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C h a p t e r

1.INTRODUCTION

OVERVIEW
This chapter provides an overview of this document and contains the following topics:

About This Guide (page 1-1)

Product Overview (page 1-2)

Conventions (page 1-4)

ABOUT THIS GUIDE
This document contains the following chapters:

Chapter 2 (Installation and Configuration), which provides details concerning the 
installation of the Web Parts product.

Chapter 3 (Using Web Parts), which explains how to use the Web Parts product 
functionality.

Chapter 4 (Customizing the Software), which describes how to customize the Web 
Parts product technology.

Chapter 5 (Administering the Software), which describes how to administer the Web 
Parts product technology.

Appendix A (Modifying Configuration Settings), which describes a configuration 
editor used to modify configuration settings. It also describes files that can be used for 
further customizations.
Web Parts User Guide 1-1



Introduction
In addition, an Index is provided at the end of this document.

Audience
This guide is intended for end users who will be accessing Web Parts product functionality 
as well as for system administrators who need to install and configure the system. If usage 
or tasks are limited to administrators, it is noted in text or in headings with (Admin Only). 

This guide assumes that the product has been installed correctly and that those 
administrators who are configuring the product are familiar with the architecture of 
Content Server. 

PRODUCT OVERVIEW
Web parts is a term used to describe functionality such as that provided by basic portlets, 
similar to the Content Portlet Suite currently available. Web Parts product technology 
enables users to interact with a Content Server using Microsoft’s SharePoint technology 
by using these web parts.

The major components involved in a typical installation include:

UCM: Universal Content Manager, which allows organizations to manage their 
documents in a central repository known as a UCM Server.

Content Server: A storage repository for content from various sources. It provides a 
solution for archiving and managing email, files, and other data types. 

SharePoint Repository: A storage repository for content using SharePoint 
technology and interface functions.

Web Parts product: A way to communicate between UCM and the Enterprise Vault 
as well as the SharePoint Repository. The Web Parts product enables corporations to 
control content in the Enterprise Vault and the SharePoint Repository.

Two primary use cases exist for the combination of the Web Parts product and SharePoint:

Using SharePoint to collaborate on documents then ‘promoting’ them to a Content 
Server for storage or use on the enterprise system. This allows users to manage 
content in SharePoint, including in workflows, collaboration projects, and so forth, 
but use Content Server for storage and retention.
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Using a SharePoint front end but storing the content behind SharePoint in a Universal 
Content Management (UCM) system. This allows users who are familiar with 
SharePoint to use that interface for many tasks.

The web parts also provide for the use of both a SharePoint content repository and a 
Content Server repository. Content items can be moved between the two systems. This 
allows consumers who are familiar with SharePoint to interact with the Content Server 
through a known interface, thus making it easier to contribute and search for content.

After installation, the Web Parts product provides a navigation tree on the SharePoint 
system with functionality available through web parts. The following is a brief description 
of this functionality. See Chapter 3 (Using Web Parts) for details on using each of these 
options.

My Saved Queries: Displays a user’s saved queries and subnodes, allowing the user 
to open a Content Server search form.

My Saved URLs: Provides access to the user’s saved URLs. After clicking the URL 
title, a new browser window opens with the URL target displayed.

My Workflow Assignments: Provides information about the user’s current workflow 
assignments.

My Checked-Out Content: Provides access to the user’s currently checked out 
content. This is only available if the user is logged in with the contributor, admin, or 
sysmanager role.

My Subscriptions: Provides access to the user’s Content Server subscriptions.

Contribution Folders (available if the Folders component is enabled): Provides 
access to folders and subfolders.

Trash (available if the Folders component is enabled): Provides access to the Trash 
folder.

The following menu items are also available to those users logged in as an Administrator:

Administration: Provides access to Web Support Server (WSS) settings.

Content Server Users: Allows access to a listing of all content server users. 

External Mapped User: Allows access to a list of all externally mapped users. 

Logs: Provides access to WSS logs. The WSS is a link between Content Server and 
SharePoint. See Chapter 2 (Installation and Configuration) for details.

Search Form Definitions: Allows administrators to design custom search forms for 
queries.
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Many of these menu options have additional options available. For example, if a user 
clicks an item’s icon a menu is displayed with actions available for that option. See 
Chapter 3 (Using Web Parts) for details about the functionality of each option.

CONVENTIONS
The following conventions are used throughout this guide:

The notation <Install_Dir>/ is used to refer to the location on your system where the 
content server instance is installed.

Forward slashes (/) are used to separate the directory levels in a path name. 
A forward slash will always appear after the end of a directory name.

Notes, technical tips, important notices, and cautions use these conventions:

Symbols Description

This is a note. It is used to bring special attention to information.

This is a technical tip. It is used to identify information that can be used 
to make your tasks easier.

This is an important notice. It is used to identify a required step or 
required information.

This is a caution. It is used to identify information that might cause loss 
of data or serious system problems.
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2.INSTALLATION AND
CONFIGURATION

OVERVIEW
This section discusses how to install the Web Parts product. It covers the following topics:

Concepts
Installation Overview (page 2-2)

Tasks
Using the Installer (page 2-3)

Installing Additional Components (page 2-4)

Adding Custom Fields to the Content Server (page 2-7)

Adding Content Server to Your SharePoint System (page 2-9)

Uninstalling the Software (page 2-24)

Interface
Select Installation Address Screen (page 2-11)

Specify Share Location Screen (page 2-12)

Automated Web Site Emails Screen (page 2-13)
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Logging Options Screen (page 2-14)

Select Sign On Support Screen (page 2-15)

Select Installation Folder Screen (page 2-16)

Specify URL Screen (page 2-17)

Administrator Name Screen (page 2-18)

SharePoint Main Screen (page 2-19)

SharePoint Site Listing Screen (page 2-20)

SharePoint Site Content Screen (page 2-21)

SharePoint Create Page Screen (page 2-22)

New Content Server Web Parts Page (page 2-23)

New Page Screen (page 2-24)

INSTALLATION OVERVIEW
the Web Parts product is installed using an Installer program on the SharePoint server. 
This process installs the following components:

The Web Support Server (WSS) which is the link between the Content Server and the 
Web Parts product. WSS is installed as a Windows service on the SharePoint server 
and it must be running in order for the Web Parts product to function.

The Support Web Application which provides AJAX handlers for the Web Parts 
product. The AJAX handlers are SharePoint server side objects that handle 
asynchronous requests from the browser. This allows client code to communicate with 
WSS through to the Content Server.

The Content Server and Web Parts product integration points. These are described in 
SharePoint configuration files, overlaid on the SharePoint directory structure.

After running the Installer, you must also install and enable components on the Content 
Server in order to complete the installation and configure the system for use. See Installing 
Additional Components (page 2-4) for details.

For complete details about supported software see your Content Server and SharePoint 
documentation.

The Web Parts product can only be used with SharePoint Portal Server 2003 and Content 
Server version 7.5.2 and later.
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USING THE INSTALLER
The installation process has three parts: installing the WebApp, installing the Content 
Server WSS, and installing the Web Parts product. One command initiates the entire 
sequence of installations.

Follow these steps perform the Web Apps setup. Click Cancel at any time to stop the 
installation process:

1. Click on the Setup file in the root directory. A message is displayed indicating that 
files are being installed, then a welcome screen is displayed. 

2. Click Next to continue. 

The Select Installation Address Screen (page 2-11) is displayed.

3. Enter the web location and the virtual directory. Click Disk Cost to view an estimate 
of the amount of space needed for the installation. Click Next to continue. 

The Specify Share Location Screen (page 2-12) is displayed.

4. Enter the pathname to the directory that will be shared over the network. This is a 
temporary directory that will be shared between the web site and the Web Support 
Sever and on the web for dynamic file output. If the directory does not exist, you can 
type the name of a new directory and it will be created. Click Next to continue. 

The Automated Web Site Emails Screen (page 2-13) is displayed.

5. Enter the email contact information for the person who will receive diagnostic 
messages. If left blank, no email is sent. Click Next to continue. 

The Logging Options Screen (page 2-14) is displayed.

6. Choose the type of logging that will be done initially. Logging can be changed later by 
selecting an option from the Log menu. See Troubleshooting (page 5-4) for details. 
The default is Enable Logging. If you select Timings Logging Enabled, timing data 
will be kept on a per-request basis. This can create larger log files and slow the 
system. It should be used for diagnostic purposes only.

Click Next to continue. 

The Select Sign On Support Screen (page 2-15) is displayed.

7. Choose the type of sign-on support to be used. If Single Sign On is selected, the 
information about the current user is used. If not selected, a user name and password 
form must be filled in for each login.

8. Click Next to continue. Click Next again to begin the WebApp installation.
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9. A message screen is displayed, indicating the installation is finished. Click Close to 
continue the installation process and install the Content Server WSS. 

The Select Installation Folder Screen (page 2-16) is displayed.

10. Enter the location of the directory where the Content Server WSS will be installed. 
Click Disk Cost to view an estimate of the amount of space needed for the 
installation. Click Everyone if the the Content Server WSS should be installed for 
anyone who uses the computer. Click Just me to install for yourself. Click Next to 
continue. 

The Specify URL Screen (page 2-17) is displayed.

11. Enter the URL to the Content Server instance to be used as a data source for the server. 
Make sure to include the URL information up to and including the /idcplg designation.

The Administrator Name Screen (page 2-18) is displayed.

12. Enter the user names on the SharePoint and Content Server for the administrator. 
Click Next to continue. 

13. An information screen is displayed, indicating the beginning of the Web Parts product 
portion of the installation. Click Next to continue.

14. A progress screen is displayed, showing the progress of the installation. When it 
completes, the software is installed and ready to use. A message is displayed 
regarding installation of SharePoint services.

15. When installation finishes, you can set up the Web Parts product configuration. See 
Post-Installation Configuration (page 2-7) for details.

INSTALLING ADDITIONAL COMPONENTS
The Web Parts product requires the installation of several components on the Content 
Server. These components support the service calls made by the WSS and are stored in the 
WSS installation directory, typically named C:\Program Files\Stellent\WSS:

WebPartsWsdls.zip (required): This contains WSDL (Web Service Definition 
Language) files that provide additional web services.

Important: By default, the Content Server port used to communicate through the socket 
layer is set to 4444. To change this value, you must change the configuration file for the 
WSS. See App Settings (page A-11) for details about this file and the settings in it. 
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IntegrationSupportServices.zip (required): This creates services that allow the Web 
Parts product to obtain user interface phrases from the Content Server for the user 
interface.

UserProxy.zip (required): This allows an administrative user to proxy as a user from 
the Web Parts product. This allows some of the web services to be used in a single 
sign-in fashion.

Folders (optional): In order to provide folders in the Web Parts product, you must 
install the Folders component on the Content Server.

These components can be installed on the Content Server using the Component Manager 
or the Component Wizard. See Installing with Component Manager (page 2-5) and 
Installing With Component Wizard (page 2-6) for details.

Installing with Component Manager
To install the necessary components using Component Manager, complete the following 
steps:

1. Open a new browser window and log into Content Server as a system administrator.

2. Go to the Administration Applets page and click the Admin Server link.

3. On the Content Admin Server page click the button of the content server instance 
where you want to install the components. 

The status page for the content server instance is displayed.

4. In the option list for the server instance, click the Component Manager link.

The Component Manager page is displayed.

5. Click the Browse button next to the Install New Component field.

6. Navigate to the appropriate component zip file, select it, and close the file selection 
dialog.

7. Click Install. 

An overview page is displayed providing a list of the items that will be installed. 

8. Click Continue. The required files will be installed. This might take a few minutes.

9. After all files have been copied, a message is displayed stating that the components 
were uploaded and installed successfully.

10. Continue installing other components by repeating steps 5 through 7. When you are 
done, click the link to enable the component and restart the server.
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The content server status page is displayed.

11. Click the restart icon to restart the content server instance.

12. Rebuild the search index (if required). 

Installing With Component Wizard
To install the components using Component Wizard, complete the following steps:

1. Start Component Wizard:

In Windows, choose Start—Programs—Content Server—<instance>—Utilities—
Component Wizard.

In UNIX, navigate to the <install_dir>/bin directory. At the command prompt, type 
ComponentWizard.

The Component Wizard main screen and the Component List screen are displayed.

2. Click Install. The Install dialog is displayed.

3. Click Select and navigate to the component zip file.

4. Double-click the zip file or click Open. The Install list displays the files that will be 
installed.

5. Click OK. All required files are now installed. This might take a few minutes.

6. After all files have been copied, you are prompted to confirm enabling the listed 
components. Click Yes.

7. Repeat steps 3 through 5 for additional components. 

8. Close Component Wizard.

9. Restart the content server.

10. Rebuild the search index (if required). 

Restarting the Content Server
Whenever you install and enable a new component, you need to restart the content server. 
If you prefer or require any down time, you might also choose to stop and then start 
Content Server with two separate commands.

Note: You can install and enable all components before restarting the Content Server. You 
do not need to restart the server after each installation.
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You can restart the content server by reinitiating the services (Windows) or by reinitiating 
the processes (UNIX). You can also restart the content server by using the Admin Server. 
You need to have the ‘sysmanager’ role to access a content server through Admin Server.

To restart a content server using Admin Server, complete the following steps:

1. Log into Content Server as a system administrator.

2. Go to the Administration Applets page and click the Admin Server link.

3. 3. On the Content Admin Server page, click the button of the content server instance 
that you want to restart.

The status page for the content server instance is displayed.

4. In the option list for the server instance, click the Start/Stop Content Server link.

5. Restart the content server by clicking the restart icon.

For more information about restarting content servers, see the administration guides 
provided with Content Server.

POST-INSTALLATION CONFIGURATION
After installing the Web Parts product software and component software on the Content 
Server, you must perform additional configuration tasks:

Adding Custom Fields to the Content Server (page 2-7)

Adding the SharePoint IP Address (page 2-8)

Adding Content Server to Your SharePoint System (page 2-9)

In addition, you may want to customize the product for use at your site. See Customization 
Tasks (page 4-2) and Appendix A (Modifying Configuration Settings) for details.

Adding Custom Fields to the Content Server
After installation, a custom field must be added to the Content Server to support 
SharePoint customizations. First change the length of the field type to be used for the 
custom field.

On the Content Server to be used with SharePoint, add the following to the 
<install_dir>/config/config.cfg file:

MemoFieldSize=2083

Restart the Content Server.
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Now follow these steps to add the custom field:

1. Log in as an administrator or subadministrator to your Content Server system.

2. Click Administration in the portal navigation bar. 

3. Click Admin Applets.

4. Click the Configuration Manager icon.

5. Click Add on the Information Fields tab of the Configuration Manager.

The Add Metadata Field Name Screen is displayed.

6. Enter SharePointUrl as the new field name. Select Memo as the field type.

7. Click OK.

The Add/Edit Metadata Field Screen is displayed. 

8. Uncheck the “Enable on User Interface” checkbox.

9. Click OK.

10. On the Configuration Manager screen, click Update Database Design (on the right 
side of the screen).

A new field has now been added to be used with SharePoint.

Adding the SharePoint IP Address
After installation, the IP address of the SharePoint server must be added to the Content 
Server’s list of trusted IP addresses. You do not have to log in to the Content Server as an 
administrator to perform these actions. 

Follow these steps to add the IP address:

1. Obtain the IP address of the SharePoint server where the web parts have been 
installed.

2. On the Content Server, select System Properties from the Windows Start menu:

Start—Programs—Content Server—instance—Utilities—System Properties

3. Click the Server tab. 

The Server Configuration screen is displayed.

4. Add the IP address of the SharePoint server to the list of IP addresses in the IP 
Address Filter line.

5. Click OK when done.
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6. Restart the Content Server.

The SharePoint server and the Content Server now have a trusted relationship established 
which allows WSS to access services.

Adding Content Server to Your SharePoint 
System
After configuring the Content Server, you need to make it available on your SharePoint 
system. 

Follow this procedure to enable access to the Content Server.

1. On the SharePoint Main Screen (page 2-19), click Sites.

The SharePoint Site Listing Screen (page 2-20) is displayed.

2. Click the name of the site where the Content Server should be added.

The SharePoint Site Content Screen (page 2-21) is displayed.

3. Click Create at the top of the page to create a new page in the site. 

The SharePoint Create Page Screen (page 2-22) is displayed.

4. Select Content Server Web Parts page.

The New Content Server Web Parts Page (page 2-23) is displayed.

5. Enter the name to be displayed throughout the site. Consult your SharePoint 
documentation for details about naming conventions.

6. Select the type of layout to be used for the site. Click any template name to see a 
sample of the layout. Additional web parts can be added to each zone. If a web part is 
not added to a zone, the zone (unless it has a fixed width) and the other zones expand 
to fill unused space when you browse the page. 

7. Choose a location where the Web Part Page will be saved. Any document libraries that 
were previously created are displayed in the list.

8. Click Create when done.

The New Page Screen (page 2-24) is displayed with the layout options you selected. You 
can further customize this page by adding, removing, or moving parts to different areas of 
the page. See Chapter 4 (Customizing the Software) for details.
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INSTALLATION INTERFACE SCREENS
The following screens are used to configure the Web Parts product on your SharePoint 
system:

Select Installation Address Screen (page 2-11)

Specify Share Location Screen (page 2-12)

Automated Web Site Emails Screen (page 2-13)

Logging Options Screen (page 2-14)

Select Sign On Support Screen (page 2-15)

Select Installation Folder Screen (page 2-16)

Specify URL Screen (page 2-17)

Administrator Name Screen (page 2-18)

SharePoint Main Screen (page 2-19)

SharePoint Site Listing Screen (page 2-20)

SharePoint Site Content Screen (page 2-21)

SharePoint Create Page Screen (page 2-22)

New Content Server Web Parts Page (page 2-23)

New Page Screen (page 2-24)
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Select Installation Address Screen

This screen is used to specify the web location for the software. This is the second screen 
in the installation series. See Using the Installer (page 2-3) for details.
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Specify Share Location Screen

This screen is used to provide a path to a directory that will be shared over the network. 
This is the third screen in the installation series. See Using the Installer (page 2-3) for 
details.
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Automated Web Site Emails Screen

This screen is used to specify who will receive diagnostic emails. This is the fourth screen 
in the installation series. See Using the Installer (page 2-3) for details.
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Logging Options Screen

This screen is used to specify the type of logging that will be initially used. This is the fifth 
screen in the installation series. See Using the Installer (page 2-3) for details.
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Select Sign On Support Screen

This screen is used to specify the type of sign on that is used. This is the sixth screen in the 
installation series. See Using the Installer (page 2-3) for details.
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Select Installation Folder Screen

This screen is used to specify the location of software installation. This is the tenth screen 
in the installation series. See Using the Installer (page 2-3) for details.
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Specify URL Screen

This screen is used to specify the URL of the Content Server used. This is the eleventh 
screen in the installation series. See Using the Installer (page 2-3) for details.
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Administrator Name Screen

This screen is used to specify the user name of the SharePoint administrator and the 
Content Server administrator. This is the twelfth screen in the installation series. See 
Using the Installer (page 2-3) for details.
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SharePoint Main Screen

The SharePoint Main Screen is the starting page for your SharePoint portal. To access this 
page, go to your SharePoint home page. To begin creating a page, click Sites at the top of 
the screen.

See your SharePoint documentation for complete details about accessing this screen and 
using other options on this screen.
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SharePoint Site Listing Screen

The Site Listing Screen displays all web sites available through the SharePoint portal. Use 
this page to add your Content Server to an existing site. To access this page, click Sites on 
the SharePoint Main Screen (page 2-19).

See your SharePoint documentation for complete details about using other options on this 
screen.
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SharePoint Site Content Screen

The Site Content Screen displays the content that is resident on the site to be used for the 
Content Server. Use this page to create a new page for your Content Server. You can add a 
variety of pages for the Content Server, as shown in the illustration. To access this page, 
click the name of the web site where the Web Parts product page will be installed on the 
SharePoint Site Listing Screen (page 2-20). 

See your SharePoint documentation for complete details about using other options on this 
screen.
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SharePoint Create Page Screen

The SharePoint Create Page Screen is used to add web pages or web part pages to your 
SharePoint site. To access this page, click Create on the SharePoint Site Content Screen 
(page 2-21).

See your SharePoint documentation for complete details about using other options on this 
screen.
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New Content Server Web Parts Page

The New Web Parts Page is used to configure the Web Parts product portal. To access this 
screen, select Content Server Web Parts Page from the SharePoint Create Page Screen 
(page 2-22).

This screen is divided into three sections:

Name: Enter a name for the page. This name will appear in headings, links, and in 
other areas throughout the Web Parts product site. Consult your SharePoint 
documentation for details about naming conventions.

Layout: Choose from one of the available layouts. You can later add and subtract 
elements from each part.

Save Location: Choose the document library from the list where the Web Parts 
product page will be stored. Any document libraries that were previously created are 
displayed in the list.
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To exit without saving your change, click Cancel. When done, click Create. 

The New Page Screen (page 2-24) is displayed in the layout you selected.

New Page Screen

The New Page screen is displayed after you choose to create a new Web Parts product 
page. See Chapter 3 (Using Web Parts) for details about using the functionality on this 
page. See Chapter 4 (Customizing the Software) for details about customizing this page.

UNINSTALLING THE SOFTWARE
To uninstall the Web Parts product, uninstall the web parts on the SharePoint server. See 
your SharePoint documentation for details.

To uninstall a Content Server component, perform these steps using either Component 
Wizard or Component Manager:

1. Disable the component.

2. Restart the content server.

3. Click Remove or Uninstall.

4. Restart the content server.
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Note: Uninstalling a component means that the content server no longer recognizes the 
component, but the component files are not deleted from the file system.
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3.USING WEB PARTS

OVERVIEW
This chapter discusses how to use the Web Parts product product. It covers the following 
topics:

Concepts
Searching and Viewing Content (page 3-4)

Accessing Frequently Used URLs (page 3-7)

Managing Workflows (page 3-8)

Managing Subscriptions (page 3-11)

Sharing Content on the Content Server (page 3-12)

Tasks
Searching Stored Content (page 3-4)

Creating a Query (page 3-6)

Executing a Saved Query (page 3-7)

Removing a Saved Query (page 3-7)

Storing a URL (page 3-7)

Using a Saved URL (page 3-8)

Removing a URL (page 3-8)
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Managing Workflows (page 3-8)

Managing Content (page 3-9)

Subscribing to Content (page 3-11)

Viewing Subscription Details and Content (page 3-12)

Unsubscribing from Content (page 3-12)

Interface
Main Page (page 3-14)

Page Header (page 3-14)

Library Listing Screen (page 3-23)

Main Navigation Tree (page 3-15)

Main Page Search Section (page 3-17)

Content Viewer Screen (page 3-17)

Item Properties Screen (page 3-19)

My Saved Queries Folder (page 3-20)

My Saved URLs Folder (page 3-20)

Saved URL Dialog Screen (page 3-21)

My Subscriptions Folder (page 3-22)

Library Listing Screen (page 3-23)

Web Part Pulldown (page 3-23)

Content Check In Screen (page 3-22)

Promote to Enterprise Menu (page 3-24)

Important: Your SharePoint system may use a different layout or options than the 
samples shown in this document. Therefore, the screen representations of pages may be 
different than those used at your site. Consult your system administrator if you are unsure 
about how to proceed.
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ACCESSING THE FUNCTIONALITY
To access the Web Parts product, click the appropriate menu option on your SharePoint 
system. The Main Page (page 3-14) is displayed.

The Portal Page is divided into sections which have different functionality. In this 
documentation, the main page is divided into three sections:

The Main Navigation Tree (page 3-15) in the left section: Displays those options that 
are available to the logged-in user. 

The Main Page Search Section (page 3-17) in the body section: Used to execute 
searches on stored content.

The header at the top of the screen: Contains the site name and the Modify Menu on 
the top right corner of the screen. This menu is used to change the layout and number 
of items on your screen. See Chapter 4 (Customizing the Software) for details on its 
use.

General Use Tips
Several shortcuts can be used on the different sections of the page:

Clicking an item number in a result list causes the default action for that item to occur.

Clicking the icon next to an item displays a list of available actions for that item.

Clicking on menu text in the Main Navigation Tree (page 3-15) displays any available 
listings in the Search Results pane.

The columns to be displayed can be changed by editing a configuration file. See 
Appendix A (Modifying Configuration Settings) for details.

In addition to these usage shortcuts, a parts submenu is also available. 

Parts Submenu
A menu is available for each page section. You can access this menu by clicking the down 
arrow ( ) in the top corner of any page section. 

This menu contains the following options. When using the Design This Page selection on 
the Modify Menu (page 4-12), other options also appear on this menu. Those special 
options are noted below:

Login: Logs you into the WSS and the Content Server.
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Logout: Logs you out of the Web Parts product portal page.

Minimize|Restore: Hides the subsection or restores it if it is hidden.

Close: Removes the section from the page. In order to use the section again, you must 
choose Reset Page Content from the Modify My Page menu. See Modifying Web 
Parts (page 4-5) for details. 

Delete: (Design This Page only): Available for Administrators only. Deletes the 
section. See Modifying Web Parts (page 4-5) for details.

Modify My|Shared Web Part: Opens the appropriate modification screen, depending 
on the section of the page that is used.

Connections: (Design This Page only): Used to allow web parts to share data. See 
your SharePoint documentation for more details.

Export: Used to access a copy of the DWP for the web part. See your SharePoint 
documentation for more details.

SEARCHING AND VIEWING CONTENT
You can search for content in the Content Server in several different ways. This section 
describes the following tasks:

Searching Stored Content (page 3-4)

Viewing Content (page 3-5)

Viewing Content Details (page 3-6)

Creating a Query (page 3-6)

Executing a Saved Query (page 3-7)

Removing a Saved Query (page 3-7)

Searching Stored Content
Use the following steps to create a listing of all content that is available through the Web 
Parts product:

1. Select All Fields from either the My Saved Queries Folder (page 3-20) or from the 
menu in the Web Search portion of the Main Page Search Section (page 3-17) in the 
Main Page (page 3-14).
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2. Click Execute to run the search.

A listing of all available documents is displayed.

Viewing Content
Follow these steps to view content checked in to the system.

1. To view content, click one of the following icons:

• My workflow assignments ( )

• My checked-out content ( )

• My subscriptions ( )

• Document in a search result ( )

2. Select the method you want to use for viewing. You can view content in different 
ways:

• View With Default Viewer: Use this option to use the viewer that is the 
designated default for your site.

The following viewing types are available when you view a document from a search 
result:

• Native File: Use this option to view the file as it was originally added to the 
system.

• Web Viewable: Use this option to view the file as it will be viewed on a web site.

• HTML Rendition: Use this option to view an alternate file checked in with the 
item. If no alternate file is available, a message dialog is displayed.

3. When you choose a content item to view, the Content Viewer Screen (page 3-17) is 
displayed. 

4. When done viewing the content item, select File—Close Window.

Note: If the system administrator for your site created specialized search forms, these 
appear in the My Saved Queries Folder (page 3-20) with a search form icon ( ). To 
execute these searches, click the search name then click Execute in the Web Search 
portion to run the search. See your system administrator for details. 
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Viewing Content Details
You can also view the metadata associated with a content item. Metadata is the data that 
describes the item, such as its check-in date, number of revisions, and other information.

1. To view an item’s details, click one of the following icons:

• My workflow assignments ( )

• My checked-out content ( )

• My subscriptions ( )

• Document in a search result ( )

2. Select Item Properties from the displayed popup menu.

The Item Properties Screen (page 3-19) is displayed.

3. When you finish viewing details, click OK.

Creating a Query
To quickly display search results for searches that you perform often, you can save links to 
those searches in the My Saved Queries Folder (page 3-20) in the Main Navigation Tree 
(page 3-15). 

Use the following procedure to save a search as a query link:

1. Select All Fields from either the My Saved Queries Folder (page 3-20) or from the 
menu in the Web Search portion of the Main Page Search Section (page 3-17) in the 
Main Page (page 3-14).

2. Specify the search criteria you want to save in the desired fields. If you change your 
mind about the criteria to be used, click the Reset button to clear the entries you made.

3. Click Execute to run the search.

4. Click Save Search in the SCS Web Parts Search Results portion of the Main Page 
Search Section (page 3-17).

A prompt dialog is displayed.

5. Enter a title for the saved query. This is the link that will be displayed in the My Saved 
Queries Folder (page 3-20).

6. Click OK.

The new link is displayed in the My Saved Queries Folder (page 3-20).
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Executing a Saved Query
Queries that have been saved can be run in one of two ways:

Click the name of the query in the My Saved Queries Folder (page 3-20). Those 
queries that do not require a script for execution run immediately. Click Execute to 
run queries requiring a script.

Select the query name from the drop down list in the SCS Web Search portion of the 
Main Page Search Section (page 3-17). Click Execute to run the query.

The results of the query are displayed in the Results area of the Main Page Search Section 
(page 3-17).

Removing a Saved Query
To remove a query from the My Saved Queries Folder (page 3-20), click the My Saved 
Query selection icon (  ) for the query you want to remove. A popup menu is displayed. 
Select Remove. The query is removed from the My Saved Queries Folder (page 3-20).

ACCESSING FREQUENTLY USED URLS
You can use the stored URL function to save the location of web sites that are frequently 
accessed. This section describes the following tasks:

Storing a URL (page 3-7)

Using a Saved URL (page 3-8)

Removing a URL (page 3-8)

Storing a URL
You can use the stored URL function to save the location of web sites that you frequently 
access. The URls are stored on the Content Server for later retrieval.

Use this procedure to save a URL for future use:

Note: If the system administrator for your site created specialized search forms, these 
appear in the My Saved Queries Folder (page 3-20) with a search form icon ( ). To 
execute these searches, click the search name then click Execute in the Web Search 
portion to run the search. See your system administrator for details. 
Web Parts User Guide 3-7



Using Web Parts
1. Click the My Saved URL icon ( ) or on the icon for any previously saved URL. 

2. Select Create New URL from the popup menu that is displayed.

The Saved URL Dialog Screen (page 3-21) is displayed.

3. Enter the name for the saved URL. This will appear in the My Saved URLs Folder 
(page 3-20) in the Main Navigation Tree (page 3-15).

4. Enter the URL for the web site.

5. Click OK when done. To cancel the save, click Cancel.

The new link is displayed in the My Saved URLs Folder (page 3-20).

Using a Saved URL
You can use a saved URL in two ways:

Click the name of the saved URL in the My Saved URLs Folder (page 3-20).

Click the My Saved URL icon ( ) next to the URL you want to access and select 
View from the displayed menu.

The target web site is displayed in a new browser window.

Removing a URL
To remove a URL from the My Saved URLs Folder (page 3-20) , follow this procedure:

1. Click the My Saved URL icon ( ) next to the URL you want to remove. 

A popup menu is displayed.

2. Select Remove.

MANAGING WORKFLOWS
A workflow specifies how content is routed for review and approval before it is released to 
the system. Users are notified by e-mail when they have a file in the workflow to review. 
Each workflow can include multiple review and notification steps, and multiple reviewers 
can be assigned to approve or reject the file at each step. For each step in a workflow, a set 
of users and a step type must be defined.

Use this procedure to view your workflow assignments and take action on the 
assignments, if needed:
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1. Click the plus sign (+) next to the Workflow Assignment icon ( ) in the Main 
Navigation Tree (page 3-15).

A list of content items in workflows you are responsible for reviewing is displayed.

You can also click the Workflow Assignment text and a list of content items is 
displayed in the Search Results pane. The list in the Search Results pane contains 
column information about the workflow actions taken and the action date.

2. Click the Assigned Workflow icon ( ) to display a menu for each workflow item. 
The following options may appear on that menu:

• Item Properties: Displays the Item Properties Screen (page 3-19) where you can 
view metadata for the item.

• Approve: If the item is awaiting your action, you can mark it as approved by 
clicking this option.

• Reject: If the item is awaiting your action, you can reject it by clicking this 
option.

• Checkin|Checkout: If the item is available to be checked in or out, you can click 
this option to perform the action.

• Undo Checkout: Used to reset the item status so it is not checked out. A message 
is displayed indicating that the item is no longer checked out to the current user.

• View with default viewer: Displays the Content Viewer Screen (page 3-17) 
where you can view the item awaiting your action.

• Workflow Review: Opens a login screen where you can view details about the 
workflow review process. After logging in to the Content Server, the Content 
Server Workflow Review screen is displayed.

A Locked Item icon ( ) indicates that the item has been checked out. It cannot proceed 
through the workflow review process until it has been checked in.

MANAGING CONTENT
With the Web Parts product you can check in items, check out items, and also change an 
item’s status. This section discusses the following tasks:

Viewing Checked-Out Content (page 3-10)

Checking Out Content (page 3-10)

Changing an Item’s Check-Out Status (page 3-11)
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Viewing Checked-Out Content
Use this procedure to view your checked-out content:

1. Click the plus sign (+) next to the My Checked Out Content ( ) icon in the Main 
Navigation Tree (page 3-15).

A list of content items that you have checked out is displayed.

2. Click the Checked Out icon ( ) in front of an item name to display a menu for each 
item:

• Item Properties: Displays the Item Properties Screen (page 3-19) where you can 
view metadata for the item.

• Check In: Displays the Content Check In Screen (page 3-22) where you add 
specific details about the current check-in of the item. 

• View with default viewer: Displays the Content Viewer Screen (page 3-17) 
where you can view the item awaiting your action.

• Undo Checkout: Used to reset the item status so it is not checked out. A message 
is displayed indicating that the item is no longer checked out to the current user.

Checking Out Content
Use this procedure to check out a content item:

1. Locate the item to be checked out by running a search and listing the item. See 
Searching Stored Content (page 3-4) and Executing a Saved Query (page 3-7) for 
details.

2. Click the document icon next to the item you want to check out from the Search 
Results part of the Main Page Search Section (page 3-17). 

3. Select Check-Out from the displayed popup menu.

The content item name is displayed in the My Checked-Out Content Folder 
(page 3-21).

Tech Tip: Click the item name to view the item’s properties.
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Changing an Item’s Check-Out Status
Follow these steps to remove the check-out status from a content item:

1. Click the Checked Out icon ( ) in front of an item name in the My Checked-Out 
Content Folder (page 3-21).

2. Select Undo Check-Out from the displayed popup menu.

The content item name is removed from the My Checked-Out Content Folder 
(page 3-21).

MANAGING SUBSCRIPTIONS
When you are subscribed to a content item, you are notified automatically whenever a new 
revision of that item has been checked in to the Content Server. These tasks are involved 
in managing subscriptions:

Subscribing to Content (page 3-11)

Viewing Subscription Details and Content (page 3-12)

Unsubscribing from Content (page 3-12)

Subscribing to Content
Follow these steps to subscribe to a content item:

1. Locate the item to be subscribed to by running a search and listing the item. See 
Searching Stored Content (page 3-4) and Executing a Saved Query (page 3-7) for 
details.

2. Click the document icon next to the item you want to subscribe to from the Search 
Results part of the Main Page Search Section (page 3-17). 

3. Select Subscribe from the displayed popup menu.

4. The first time you subscribe to an object, you are prompted to enter your email 
address. Email notifications will be sent to you when the item’s status changes. If you 
log out and log back in, you will need to enter your contact information again.

5. Click OK after entering your contact information.

The content item name is displayed in the My Subscriptions Folder (page 3-22).
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Viewing Subscription Details and Content
You can view details about the content items to which you are subscribed or view the 
content item itself. See Viewing Content (page 3-5) and Viewing Content Details 
(page 3-6) for information.

Unsubscribing from Content
Follow these steps to unsubscribe from a content item:

1. Click the subscription icon ( ) next to the name of the subscribed item in the My 
Subscriptions Folder (page 3-22).

2. Select Unsubscribe from the displayed popup menu.

The content item name is removed from the My Subscriptions Folder (page 3-22).

SHARING CONTENT ON THE CONTENT SERVER
When content is ‘promoted’ from the SharePoint server to the Content Server, it is 
removed from the SharePoint server. A link remains to the item in SharePoint so the user 
can access it in the Content Server from SharePoint. However, once it has been promoted, 
it is now stored in the Content Server. It cannot be edited on the SharePoint system until it 
is returned. 

To promote an item to the Content Server, follow these steps:

1. Select the Document Library where the page is stored from the list on the SharePoint 
Site Content Screen (page 2-21).

The Library Listing Screen (page 3-23) is displayed.

2. Rest your cursor on the content item to be promoted.

The Web Part Pulldown (page 3-23) is displayed.

3. Select Promote to Enterprise from the Promote to Enterprise Menu (page 3-24).

The Content Check In Screen (page 3-22) is displayed.

4. Fill in the appropriate information. Click OK when done.

Important: Pages are promoted from the SharePoint server, not from the Web Parts 
product page. 
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When an item has been promoted to the Content Server, it can no longer be edited in the 
SharePoint system. The item is viewable, but cannot be changed until it is brought back 
for editing.

To return an item to SharePoint, follow these steps:

1. Select the Document Library where the page is stored from the list on the SharePoint 
Site Content Screen (page 2-21).

The Library Listing Screen (page 3-23) is displayed.

2. Rest your cursor on the content item to be returned.

The Web Part Pulldown (page 3-23) is displayed.

3. Select Bring Back to SharePoint from the Promote to Enterprise Menu (page 3-24). 
This option appears for those items which have been promoted and are now available 
for return.

INTERFACE SCREENS
The following screens are used when accessing the Web Parts product:

Main Page (page 3-14)

Page Header (page 3-14)

Library Listing Screen (page 3-23)

Main Navigation Tree (page 3-15)

Main Page Search Section (page 3-17)

Content Viewer Screen (page 3-17)

Item Properties Screen (page 3-19)

My Saved Queries Folder (page 3-20)

My Saved URLs Folder (page 3-20)

Saved URL Dialog Screen (page 3-21)

My Subscriptions Folder (page 3-22)

Library Listing Screen (page 3-23)

Web Part Pulldown (page 3-23)

Content Check In Screen (page 3-22)
Web Parts User Guide 3-13



Using Web Parts
Promote to Enterprise Menu (page 3-24)

Main Page

The main page contains the elements of the Web Parts product that have been selected for 
use at your site. This screen can be customized to create a page that addresses the specific 
needs of users in your environment. Because of that, the screen shown here may differ 
than the one in use at your site.

This screen is divided into several different sections:

Page Header (page 3-14)

Main Navigation Tree (page 3-15)

Main Page Search Section (page 3-17)

Click the section down arrow ( ) to display a menu containing options available for that 
portal section. 

Page Header

The Page Header contains the customized icon and header text for your page. See 
Customizing the Title Bar (Admin Only) (page 4-6) for details about customizing the 
header.
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The Modify Menu (page 4-12) is also available in the header section. See Chapter 4 
(Customizing the Software) for details about using the options on this menu.

Main Navigation Tree

The Main Navigation Tree contains those options which have been selected for use at your 
site. This provides you with a quick access point to all actions you are allowed to perform. 
The Navigation Tree shown here displays all possible options. Only those users who have 
the Administrative role will see all of these options.

Options on the Navigation Tree vary from site to site. Web parts can be added and 
removed, according to what is needed for each enterprise.

Tech Tip: If you click the text next to the icons in the Navigation tree, a list of items is 
displayed in the Search Results portion of the Main Page Search Section (page 3-17). For 
example, if you click My Saved URLs, a list of saved URLs is splayed in the Search 
Results pane.

Icon Description

The home icon is accompanied by the name of the 
logged in user. 

Administration (Admin Only): Opens the Main Admin 
Screen (page 5-6) where administrators can modify 
aspects of the system.
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My Saved Queries: Displays a list of queries that were 
created and saved. See Creating a Query (page 3-6) for 
more details.

My Saved URLs: Displays a list of saved URLs. See 
Storing a URL (page 3-7) for details.

My Workflow Assignments: Displays a list of content 
items currently in workflow and assigned to this user 
for review.

My Checked Out Content: Displays the names of 
content items that are checked out by the logged in 
user.

My Subscriptions: Displays the names of content items 
to which the user is currently subscribed. See 
Subscribing to Content (page 3-11) for details.

Content Server Users: Displays a list of users who have 
a Content Server account.

External Mapped Users: Displays a listing of users 
who are defined on the SharePoint server and who are 
mapped to a different Content Server user identity.

Search Form Definition: Displays previously created 
search forms, which can be used to screen content. See 
Designing Custom Search Forms (Admin Only) 
(page 4-3) for details.

Contribution Folders: If folders are installed, accesses 
a list of folders.

Trash: If folders are installed, accesses the folder trash 
directory.

Icon Description
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Main Page Search Section

The Search Section of the main page is divided into two areas: the Web Parts Search and 
the Web Parts Search Results. 

The Web Parts Search area is used to select a saved search or to select All Fields in 
order to select fields for searching.

The Web Parts Search Results area displays the result of the executed search.

See Searching Stored Content (page 3-4) and Creating a Query (page 3-6) for details.

Content Viewer Screen

Logs: Displays the Log Menu Screen (page 5-7). See 
Troubleshooting (page 5-4) for details about using log 
files.

Icon Description
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The Content Viewer screen is used to preview content items. To access this screen, select a 
viewing option after clicking any of the following icons:

• My workflow assignments ( )

• My checked-out content ( )

• My subscriptions ( )

• Document in a search result ( )

If you have previously viewed content, the screen displays tabs with the name of the 
previously displayed content item in each tab. Clicking on a tab displays a page with that 
content.

The following options are available from the File menu on this screen:

Open in New Window: Displays the item in a new window.

Close Active Tab: Closes the current content page.

Close All But Active Tab: Closes all previously displayed content and keep only the 
active content page open.

Close All Tabs: Closes all pages but keep the Content Viewer Screen open.

Close Window: Closes the Content Viewer Screen.
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Item Properties Screen

The Item Properties screen displays the metadata associated with the content item as well 
as information about revisions.

To access this screen, click any of the following icons:

• My workflow assignments ( )

• My checked-out content ( )

• My subscriptions ( )

• Document in a search result ( )

Select Item Properties from the displayed menu. When done, click OK.
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My Saved Queries Folder

The My Saved Queries portion of the Main Navigation Tree (page 3-15) displays the 
queries that were created and saved for the logged-in user. See Creating a Query 
(page 3-6) for details.

My Saved URLs Folder

The My Saved URLs portion of the Main Navigation Tree (page 3-15) displays the URLs 
that were saved for the logged-in user. See Storing a URL (page 3-7) for details.

Note: Item Properties is used to view the metadata about a content item, such as its 
content ID, checkin-in information, and revisions. It is not used to view the actual content 
item.
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Saved URL Dialog Screen

The Saved URL Dialog screen is displayed when a query is created. To access this screen, 
select Create New URL from the popup menu when an icon is clicked in the My Saved 
URLs Folder (page 3-20). See Storing a URL (page 3-7) for details.

 

My Checked-Out Content Folder

The My Checked-Out Content portion of the Main Navigation Tree (page 3-15) displays 
the content checked out to the current user. See Checking Out Content (page 3-10) for 
details.

Field Description

Name
The name for the link that will appear in the My Saved 
URLs Folder (page 3-20).

URL
The web site location for the URL to be associated 
with the name.
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My Subscriptions Folder

The My Subscriptions portion of the Main Navigation Tree (page 3-15) displays the 
subscriptions created and saved for the logged-in user. See Subscribing to Content 
(page 3-11) for details.

Content Check In Screen
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The Content Check In form is used to add information about items being checked into the 
Content Server. To access this screen, click Check In from the Checkout Out icon ( ) 
menu.

Library Listing Screen

The Library Listing screen shows those web parts that are available for use. To access this 
page, select the library name from the SharePoint Site Content Screen (page 2-21).

See your SharePoint documentation for complete details about using other options on this 
screen.

Web Part Pulldown

The Web Part Pulldown is available by resting the cursor on the web part name in the 
Library Listing Screen (page 3-23). This menu is used to promote content for use in the 
SharePoint server. See Sharing Content on the Content Server (page 3-12) for details.
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Promote to Enterprise Menu

The Promote to Enterprise menu is used to store content on the Content Server for use on 
other sites. To access this menu, rest the cursor on a content name. The Web Part Pulldown 
(page 3-23) is displayed. Click the down arrow ( ) to display the menu. 

See your SharePoint documentation for complete details about using other options on this 
menu.
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C h a p t e r

4.CUSTOMIZING THE SOFTWARE

OVERVIEW
Both administrators and non-administrative users can customize the Web Parts product for 
their personal use. This chapter discusses how to customize the product for all users, 
which is an administrative function, and for personal use.

See Chapter 5 (Administering the Software) for details about administering the product, 
including changing directory paths, defaults, and troubleshooting information. See 
Appendix A (Modifying Configuration Settings) for details about further customizations 
that can be performed by system administrators.

Tasks
Choosing a Page to Customize (Admin Only) (page 4-3)

Designing Custom Search Forms (Admin Only) (page 4-3)

Adding Web Parts (Admin Only) (page 4-4)

Add Web Parts by Browsing (page 4-4)

Add Web Parts by Searching (page 4-5)

Add Web Parts by Importing (page 4-5)

Customizing the Title Bar (Admin Only) (page 4-6)

Customizing the Navigation Tree (page 4-7)

Customizing the Search Criteria Section (page 4-8)

Modifying the Layouts and Advanced Settings (page 4-9)
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Customizing the Search Results Section (page 4-8)

Designing the Page (page 4-11)

Interface
Modify Menu (page 4-12)

Search Form Options Screen (Admin Only) (page 4-13)

Define New Search Form Screen (Admin Only) (page 4-14)

Add Web Parts Menu (Admin Only) (page 4-14)

Add Web Parts (Browse) Screen (Admin Only) (page 4-15)

Add Web Parts (Search) Screen (Admin Only) (page 4-16)

Add Web Parts (Import) Screen (Admin Only) (page 4-17)

Modify Web Parts Screen (page 4-17)

Change Page Title Screen (Admin Only) (page 4-18)

Change Navigation Tree Screen (page 4-19)

Change Search Criteria Screen (page 4-20)

Change Search Results Screen (page 4-21)

Layout and Advanced Screen (page 4-22)

CUSTOMIZATION TASKS
You can alter the layout, wording, and appearance of the different parts of your Web Parts 
product page. If you log in as an administrator, you can change the appearance for all users 
at your site. Users can also change the page to suit their personal preferences.

This section describes how to customize the Web Parts product page. Functionality that is 
only available to administrators is indicated by the words Admin Only in the title. This 
section covers the following topics:

Choosing a Page to Customize (Admin Only) (page 4-3)

Designing Custom Search Forms (Admin Only) (page 4-3)

Adding Web Parts (Admin Only) (page 4-4)

Modifying Web Parts (page 4-5)
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Customizing the Title Bar (Admin Only) (page 4-6)

Customizing the Navigation Tree (page 4-7)

Customizing the Search Criteria Section (page 4-8)

Customizing the Search Results Section (page 4-8)

Designing the Page (page 4-11)

Choosing a Page to Customize (Admin Only)
If you log in as an Administrator, you have the option to modify the page for all users or 
only for yourself.

To modify the page for all users, click Shared View on the Modify Menu (page 4-12). 

To modify the page for your own use, click Personal View on the Modify Menu 
(page 4-12).

A box is displayed around the shared icon ( ) or the personal icon ( ), indicating 
which option is selected.

Designing Custom Search Forms (Admin Only)
If you log in as an administrator, you can design a custom search form that limits the 
metadata seen by users. This enables you to minimize the data that users can see and also 
simplifies their search process.

Follow these steps to design a custom search form:

1. Click Search Form Definitions on the Main Navigation Tree (page 3-15).

The Search Form Options Screen (Admin Only) (page 4-13) is displayed.

2. Select a definition to use for your search form. You can modify the fields that are 
included in the search.

The Define New Search Form Screen (Admin Only) (page 4-14) is displayed.

3. Enter a name for the new search form.

4. Add or remove fields to be included in the search.

Click Cancel to exit without saving the search form. Click OK when done. 
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The new search is displayed in the My Saved Queries Folder (page 3-20) with a search 
form icon ( .), which is different than the icon used for personally created queries 
( ).

Adding Web Parts (Admin Only)
Administrators can delete or add web parts to the page. Any changes that are made will be 
available to all users who have access to the page.

There are three ways to add web parts to the page:

Add Web Parts by Browsing (page 4-4)

Add Web Parts by Searching (page 4-5)

Add Web Parts by Importing (page 4-5)

Use this procedure to modify the content of the web parts page:

1. Click the Modify Menu (page 4-12).

2. Click the horizontal arrow next to Add Web Parts.

The Add Web Parts Menu (Admin Only) (page 4-14) is displayed.

3. Select the method you want to use to add web parts.

On any of these screens to widen the screen, click the arrow icon next to the title of the 
screen. When done, click the X icon at the top right corner of the screen. The screen 
closes.

Add Web Parts by Browsing
If you select Browse, the Add Web Parts (Browse) Screen (Admin Only) (page 4-15) is 
displayed. Use this screen to search through galleries for additional web parts to add to 
your page.

1. Select the gallery you want to use. A list of available elements is displayed at the 
bottom of the screen

2. Click the web part you want to use.

Note: The search form does not appear in the folder until you log out and log back in.

Tech Tip: Rest the cursor on each gallery name. A brief description of the gallery and its 
contents is displayed.
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3. Select the area of the page where the element will be inserted. Available options 
depend on what type of layout you chose for your Web Parts product page.

4. Click Add when done to insert the web part.

The new element is added to the location you specified. Use this procedure to continue 
adding more elements to your page. 

Add Web Parts by Searching
If you select Search, the Add Web Parts (Search) Screen (Admin Only) (page 4-16) is 
displayed. Use this screen to search for a specific element to include on your page.

1. Enter the search term to use.

2. Click Go.

3. All available galleries are searched. 

4. Select the area of the page where the element will be inserted. Available options 
depend on what type of layout you chose for your Web Parts product page.

5. Click Add when done to insert the web part.

Add Web Parts by Importing
If you select Import, the Add Web Parts (Import) Screen (Admin Only) (page 4-17) is 
displayed. Use this screen to import customized web parts, such as titles and help links.

1. Enter the file name with the .dwp extension or use the Browse button to search for a 
web part.

2. After selecting a file to import, click Upload.

3. Select the area of the page where the element will be inserted. Available options 
depend on what type of layout you chose for your Web Parts product page.

4. Click Add when done.

Modifying Web Parts
You can modify individual sections of the Web Parts product page by using the Modify 
My Web Parts or Modify Shared Parts options on the Modify Menu (page 4-12). 
Modify Shared Parts is only available on menus when the user has Administrative 
privileges.
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Administrators can change the title bar on the Web Parts product page. All users can 
change the navigation tree, search criteria pane, and the search result pane for their 
personal use. This section describes the following tasks:

Customizing the Title Bar (Admin Only) (page 4-6)

Customizing the Navigation Tree (page 4-7)

Customizing the Search Criteria Section (page 4-8)

Customizing the Search Results Section (page 4-8)

When you modify a section of the page, highlighting is displayed around the section, 
indicating which area is being changed.

Figure 4-1 Modification highlighting

Clicking the down arrow (  ) displays the Parts Submenu (page 3-3), which can be used 
to quickly change aspects of the section. Clicking the X closes the screen.

Customizing the Title Bar (Admin Only)
Follow this procedure to customize the header section of the Web Parts product page.

1. Select Web Part Page Title Bar from the Modify Web Parts Screen (page 4-17).

The Change Page Title Screen (Admin Only) (page 4-18) is displayed.

2. Enter the title to be displayed at the top of the page.

Note: If you modified shared web parts and closed a web part using the Parts Submenu 
(page 3-3), that web part no longer appears on the Modify Web Parts menu. Only active 
web parts appear on the menu. In addition, if you unchecked Visible on Page on the 
Layout portion for the section, (Hidden) is displayed in front of the title.
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3. Enter a caption to appear above the title.

4. Enter a description. This description is displayed on any listings of the page.

5. To use an alternate icon to appear with the title, enter the pathname where the image is 
located.

6. To view the results of your changes, click Apply. To save the changes, click OK. To 
cancel the changes, click Cancel.

Customizing the Navigation Tree
Follow this procedure to customize the navigation section of the Web Parts product page.

1. Select SCS Web Part Navigation Tree from the Modify Web Parts Screen 
(page 4-17).

The Change Navigation Tree Screen (page 4-19) is displayed.

2. Enter the title to be displayed at the top of the navigation section.

3. Select a height for the section. Click Yes if you want to enter a specific height for the 
navigation section. Click No to adjust the height to fit the designated section.

4. Select a width for the section. Click Yes if you want to enter a specific width for the 
navigation section. Click No to adjust the width to fit the designated section.

5. Select a Frame State for the section. If you want to have the section always 
minimized, click Minimized. If you want the section to always be available, click 
Normal. Minimized sections can be maximized by clicking on the maximize icon.

6. Select a Frame Style for the section. The options include:

• None: no frame will appear around the navigation section.

• Title Bar and Border: A colored title bar and thin border is displayed around the 
section.

• Title Bar Only: A colored title bar is displayed with no border.

• Default: The default for your SharePoint system.

7. Change the layout and link information. See Modifying the Layouts and Advanced 
Settings (page 4-9) for details.

8. To view the results of your changes, click Apply. To save the changes, click OK. To 
cancel the changes, click Cancel.

Note: If the Navigation Title has been previously changed, that title appears on the menu 
in place of SCS Web Part Navigation Tree.
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Customizing the Search Criteria Section
Follow this procedure to customize the navigation section of the Web Parts product page.

1. Select SCS Web Part Search from the Modify Web Parts Screen (page 4-17).

The Change Search Criteria Screen (page 4-20) is displayed.

2. Enter the title to be displayed at the top of the section.

3. Select a height for the section. Click Yes if you want to enter a specific height for the 
section. Click No to adjust the height to fit the designated zone.

4. Select a width for the section. Click Yes if you want to enter a specific width for the 
section. Click No to adjust the width to fit the designated zone.

5. Select a Frame State for the section. If you want to have the section always 
minimized, click Minimized. If you want the section to always be available, click 
Normal. Minimized sections can be maximized by clicking on the maximize icon.

6. Select a Frame Style for the section. The options include:

• None: no frame will appear around the section.

• Title Bar and Border: A colored title bar and thin border is displayed around the 
section.

• Title Bar Only: A colored title bar is displayed with no border.

• Default: The default for your SharePoint system.

7. Change the layout and link information. See Modifying the Layouts and Advanced 
Settings (page 4-9) for details.

To view the results of your changes, click Apply. To save the changes, click OK. To 
cancel the changes, click Cancel.

Customizing the Search Results Section
Follow this procedure to customize the search results section of the Web Parts product 
page.

1. Select SCS Web Part Search Results from the Modify Web Parts Screen 
(page 4-17).

Note: If the Search Section Title has been previously changed, that title appears on the 
menu in place of SCS Web Part Search.

Note: If the Search Results Title has been previously changed, that title appears on the 
menu in place of SCS Web Part Search Results.
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The Change Search Results Screen (page 4-21) is displayed.

2. Enter the title to be displayed at the top of the section.

3. Select a height for the section. Click Yes if you want to enter a specific height for the 
section. Click No to adjust the height to fit the designated zone.

4. Select a width for the section. Click Yes if you want to enter a specific width for the 
section. Click No to adjust the width to fit the designated zone.

5. Select a Frame State for the section. If you want to have the section always 
minimized, click Minimized. If you want the section to always be available, click 
Normal. Minimized sections can be maximized by clicking on the maximize icon.

6. Select a Frame Style for the section. The options include:

• None: no frame will appear around the section.

• Title Bar and Border: A colored title bar and thin border is displayed around the 
section.

• Title Bar Only: A colored title bar is displayed with no border.

• Default: The default for your SharePoint system.

7. Change the layout and link information. See Modifying the Layouts and Advanced 
Settings (page 4-9) for details.

8. Click the Maximize button (+) next to WSS Data to change the WSS Data 
information. See Modifying WSS Data (page 4-10) for details.

To view the results of your changes, click Apply. To save the changes, click OK. To 
cancel the changes, click Cancel.

Modifying the Layouts and Advanced Settings
If you click the Maximize button (+) next to Layout or Advanced on a customization page 
the Layout and Advanced Screen (page 4-22) is displayed.

Use the Layout portion of this screen to change the following information:

Visible on Page: Check this box to make the section visible on the page. If this box is 
unchecked, the section is hidden.

Direction: Select the direction in which text will flow. Options include:

• Left to right: Icons appear on the left of menu text

• Right to left: Icons appear on the right side of menu text

• Default: The default for your system is used.
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Zone: Select the location for the section. Options include:

• Header: The section is displayed in the top portion of the page.

• Left column: The section is displayed in the left portion of the page.

• Body: The section is displayed in the center, larger portion of the page.

Part Order: Select the location for the section in relation to other web parts in that 
zone. 

Use the Advanced portion of this screen to change the following information. This 
information is retained with the web part if it is exported at a later time:

Allow Minimize: If checked, this option is displayed on the section’s submenu, 
enabling users to minimize the section and display only the title.

Allow Close: If checked, this option is displayed on the section’s submenu, enabling 
users to close the section. If a section is closed, it is no longer accessible and must be 
inserted again by modifying the web parts. See Adding Web Parts (Admin Only) 
(page 4-4) for details.

Allow Zone Change: If checked, this option is displayed on the section’s submenu, 
enabling users to move the section to a different zone.

Allow Export Sensitive: Enables exporting for re-use in other pages.

Detail Link: 

Description: A description of the web part used in the section.

Help Link: A link to the help file for this web part.

Icon File (Large): The pathname to the icon file to be used for the web part.

Icon File (Small): The pathname to the icon file to be used for this web part.

Missing Assembly Error: The error message displayed if the web part for this section 
is missing.

To view the results of your changes, click Apply. To save the changes, click OK. To 
cancel the changes, click Cancel.

Modifying WSS Data
If you select Modify WSS Data from the Change Search Results Screen (page 4-21), the 
the Change WSS Data Screen (page 4-23) is displayed. Use this screen to change the 
search stack, the search name, and the context menu folder. See your SharePoint 
documentation for more details.
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To view the results of your changes, click Apply. To save the changes, click OK. To 
cancel the changes, click Cancel.

Designing the Page
The Design This Page option on the Modify Menu (page 4-12) can be used to move web 
part sections on the page. After selecting this option, move the cursor to the title portion of 
any section. The cursor changes to a four-way directional arrow. Drag the section to the 
new location. When finished, select Design This Page from the Modify Menu to return to 
normal usage.

Additional menu options are also available on the Parts Submenu (page 3-3) in the top 
right corner of each section. Those special options are noted below:

Login: Logs you into the WSS and the Content Server.

Logout: Logs you out of the Web Parts product portal page.

Minimize|Restore: Hides the subsection or restores it if it is hidden.

Close: Removes the section from the page. You can also close a section by clicking 
the X in the upper right corner of the section. To add the section back, click Reset 
Page Content on the Modify My Page menu. If you are an administrative user and 
closed the section for all users (Shared View), add the section back by using the Add 
Web Parts option on the Modify My Page menu. The section is made available in the 
Galleries list in the Browse option.

Delete: (Admin Only): Deletes the section. If the section was imported, it is no longer 
accessible and a DWP file describing it must be imported again. If the section came 
from an available gallery accessible through the Browse option, it will still be there for 
later use. 

Modify My|Shared Web Part: Opens the appropriate modification screen, depending 
on the section of the page that is used.

Connections: (Admin Only): Used to allow web parts to share data. See your 
SharePoint documentation for more details.

Export: (Admin Only): Used to access a copy of the DWP for the web part. See your 
SharePoint documentation for more details.
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THE CUSTOMIZATION INTERFACE
The following screens are used when customizing the Web Parts product page:

Modify Menu (page 4-12)

Search Form Options Screen (Admin Only) (page 4-13)

Define New Search Form Screen (Admin Only) (page 4-14)

Add Web Parts Menu (Admin Only) (page 4-14)

Add Web Parts (Browse) Screen (Admin Only) (page 4-15)

Add Web Parts (Search) Screen (Admin Only) (page 4-16)

Add Web Parts (Import) Screen (Admin Only) (page 4-17)

Modify Web Parts Screen (page 4-17)

Change Page Title Screen (Admin Only) (page 4-18)

Change Navigation Tree Screen (page 4-19)

Change Search Criteria Screen (page 4-20)

Change Search Results Screen (page 4-21)

Layout and Advanced Screen (page 4-22)

Modify Menu

The Modify Menu is used to customize the appearance of the web parts page. If you select 
Shared View, the Design this page option is grayed out because that is only available to 
individual users. In addition, the Modify My Web Parts option is changed to Modify 
Shared Web Parts.

To access this menu, click Modify Shared Page or Modify My Page in the Page Header 
(page 3-14).

The following options are available on this menu:
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Add Web Parts: Used to add additional web parts to the page. See Adding Web Parts 
(Admin Only) (page 4-4) for details.

Design This Page: Used to rearrange elements on the page. See Designing the Page 
(page 4-11) for details.

Modify My|Shared Web Parts: Used to modify specific sections of the page. See 
Modifying Web Parts (page 4-5) for details.

Shared View (Admin Only): Used to specify that any changes made will take place 
to the shared view.

Personal View: Used to specify that any changes made will take place to the user’s 
personal view.

Search Form Options Screen (Admin Only)

The Search Form Options screen is used to help define a new Search Form. To access this 
screen, click Search Form Definitions in the Main Navigation Tree (page 3-15). The 
Search Form Options Screen is displayed in the Main Page Search Section (page 3-17).

See Designing Custom Search Forms (Admin Only) (page 4-3) for details about creating a 
custom search form.
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Define New Search Form Screen (Admin Only)

The Define New Search Form Screen is used to create a title for a defined search and to 
alter any fields used in the search.

To access this page, click Create Form on the Search Form Options Screen (Admin Only) 
(page 4-13). See Designing Custom Search Forms (Admin Only) (page 4-3) for details 
about creating a custom search form.

Add Web Parts Menu (Admin Only)

The Add Web Parts Menu is used to change the web parts available on the Main Page 
(page 3-14).

To access this menu, click Add Web Parts on the Modify Menu (page 4-12) near the top 
of the Main Page (page 3-14).

The following options appear on this menu:

Browse: Opens the Add Web Parts (Browse) Screen (Admin Only) (page 4-15) where 
you can browse for parts to add to the page.

Search: Opens the Add Web Parts (Search) Screen (Admin Only) (page 4-16) where 
you can enter search terms to find parts to add to the page.

Import: Opens the Add Web Parts (Import) Screen (Admin Only) (page 4-17) where 
you can browse for parts outside your site then upload them to the page.
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Add Web Parts (Browse) Screen (Admin Only)

The Add Web Parts (Browse) Screen is used to browse existing galleries for web parts to 
include on your page.

To access this screen, click Add Web Parts on the Modify Menu (page 4-12). Select 
Browse from the Add Web Parts Menu (Admin Only) (page 4-14).
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Add Web Parts (Search) Screen (Admin Only)

The Add Web Parts (Search) Screen is used to find web parts to include on your page by 
using a keyword search.

To access this screen, click Add Web Parts on the Modify Menu (page 4-12). Select 
Search from the Add Web Parts Menu (Admin Only) (page 4-14).
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Add Web Parts (Import) Screen (Admin Only)

The Add Web Parts (Import) Screen is used to add new web parts on your page.

To access this screen, click Add Web Parts on the Modify Menu (page 4-12). Select 
Import from the Add Web Parts Menu (Admin Only) (page 4-14).

Modify Web Parts Screen

The Modify Shared Web Parts|Modify My Web Parts screen is used to alter the web parts 
used on the Web Parts product page. Administrators can change the title bar on the page. 
All users can change the navigation tree, search criteria pane, and the search result pane. 

To access this menu, click the Modify Menu (page 4-12). Select Modify My Web Parts or 
Modify Shared Web Parts.
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Change Page Title Screen (Admin Only)

The Change Page Title Screen is used to change the header information at the top of the 
Web Parts product page. To access this screen, click Add Web Parts on the Modify Menu 
(page 4-12) then click Web Part Page Title Bar.
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Change Navigation Tree Screen

The Change Navigation Tree Screen is used to change the information in the navigation 
portion of the Web Parts product page. To access this screen, click Modify Shared Web 
Parts or Modify My Web Parts from the Modify Menu (page 4-12). Click SCS Web 
Part Navigation Tree.

Note: If the Navigation Title has been previously changed, that title appears on the menu 
in place of SCS Web Part Navigation Tree. In addition, if you unchecked Visible on 
Page on the Layout portion for the section, (Hidden) appears in front of the title.
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Change Search Criteria Screen

The Change Search Criteria Screen is used to change the information in the Search criteria 
section of the Web Parts product page. To access this screen, click Modify Shared Web 
Parts or Modify My Web Parts from the Modify Menu (page 4-12). Click SCS Web 
Part Search.

Note: If the Web Part Search Title has been previously changed, that title appears on the 
menu in place of SCS Web Part Search. In addition, if you unchecked Visible on Page 
on the Layout portion for the section, (Hidden) appears in front of the title.
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Change Search Results Screen

The Change Search Result Screen is used to change the information in the Search Result 
section of the Web Parts product page. To access this screen, click Modify Shared Web 
Parts or Modify My Web Parts from the Modify Menu (page 4-12). Click SCS Web 
Part Search Results.

Note: If the Web Part Search Results Title has been previously changed, that title appears 
on the menu in place of SCS Web Part Search Results. In addition, if you unchecked 
Visible on Page on the Layout portion for the section, (Hidden) appears in front of the 
title.
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Layout and Advanced Screen

The Layout and Advanced screen is used to set the layout of elements on the web part 
page. To access this screen, click the Maximize button (+) next to Layout or Advanced on 
a customization page.
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Change WSS Data Screen

The WSS Data Screen is used to alter WSS data criteria. To access this screen, click 
Modify WSS Data from the Change Search Results Screen (page 4-21). 
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C h a p t e r

5.ADMINISTERING THE SOFTWARE

OVERVIEW
This section covers the following topics:

Concepts
Administration Options (page 5-1)

Other Admin-Only Functionality (page 5-3)

Troubleshooting (page 5-4)

Tasks
Automatic User Logging (page 5-4)

Using Log Files (page 5-4)

Interface
Main Admin Screen (page 5-6)

Log Results Screen (page 5-9)

ADMINISTRATION OPTIONS
The Administration option on the Main Navigation Tree (page 3-15) is used to configure 
system specific elements of the Web Parts product.
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When you click this option, the Main Admin Screen (page 5-6) is displayed. This 
Administration Screen is divided into three general categories:

WSS Information (page 5-2)

Defaults (page 5-2)

Content Server Information (page 5-3)

To access this screen, log in as an administrator. Select Administration from the Main 
Navigation Tree (page 3-15). The Main Admin Screen (page 5-6) is displayed.

After making edits, click Save to save your changes. Click Reset to clear your changes 
and reinstate the previously saved configuration. Click Reset WSS cache to clear the Web 
Support Server cache directory but leave all other configuration unchanged.

WSS Information
The following Web Support Server information can be edited on this screen:

Web Support Server Diagnostics - Trace all available reporting points: If checked, all 
reporting points will be added to log files.

Web Support Server Diagnostics - Use console output: If checked, console output will 
be added to log files.

Web Support Server Diagnostics - Trace Key Points: If checked, key or main entry 
points into WSS are added to the log files.

Web Support Server - Session Timeout (minutes): Sets the number of minutes until the 
system times out after inactivity.

Web Support Server.Session.Store.GlobalCacheTimeoutMinutes: Sets the number of 
minutes until the cache times out after inactivity.

WebSupportServer.DefaultUserSetting.WSS.Logs.PageRowCount: Sets the number 
of rows on a WSS log file.

Defaults
You can set several different defaults for users. These defaults are applicable for all web 
pages designed using the Web Parts product.

The following defaults can be set:

Default User Setting - Content Page Row Count: Sets the default size for the number 
of rows used when returning search results.
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Paged Resource Retriever - Used Saved Column Widths: Sets the default column 
width for search columns.

Content Server Information
The following options can be set to determine how the Content Server is used by others at 
your site:

Stellent Content Server - Web Service Connection URL: Sets the URL for the web 
service.

Stellent Content Server - Trusted System User Name: Sets the administrator’s login 
name.

Stellent Content Server - Use Sockets: Sets how many sockets to use.

Stellent Content Server - End Point Socket: Sets the address of the end point socket.

Stellent.Scs.WebServiceSupport.UseProxy: If set to true, proxies are used. If set to 
false, proxies are not used.

Stellent.Scs.WebServiceSupport.SystemUserName: Sets the administrator’s name for 
WSS.

OTHER ADMIN-ONLY FUNCTIONALITY
Several menu options are available only to those users who have administrative privileges. 
These include:

Administration: Clicking this displays the Main Admin Screen (page 5-6) where 
administrators can set WSS information, defaults, and content server information. See 
Administration Options (page 5-1) for details. 

Content Server Users: Clicking this node option displays a list of users in the Search 
Results pane who are assigned Content Server accounts and their email addresses.

External Mapped Users: Clicking this node option displays a list of users in the Search 
Results pane who have been externally mapped to use the SharePoint server. The list 
displays the source name of the user and the target name.

Search Form Definitions: Clicking this node option displays a list of search forms in 
the Search Results pane. The list displays the name of the search form and the fields 
used as search criteria. For more details about creating search forms, see Designing 
Custom Search Forms (Admin Only) (page 4-3).
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Logs: Clicking this node option displays all log files that have been created. These log 
files can be filtered for display according to specific criteria. See Troubleshooting 
(page 5-4) for more details.

TROUBLESHOOTING
You can use configuration file changes or log files to troubleshoot the performance of the 
Web Parts product system.

Automatic User Logging
It may be useful to turn logging on when a person with a particular user name logs in to 
WSS (for example, if that user is experiencing intermittent problems that can’t be 
reproduced reliably).

To do this, modify the UserLogDefinitions section of the WSS configuration file. The 
following sample code illustrates the changes you can make:
<!--User Log Definitions: Used to determine which users should be logged even if 
the logging is off. To log a user’s activity when they in even if logging is off, 
add the user’s name here. The compare is case-insensitive-->
<UserLogDefinitions>

<Items>
<clear />
<!-- Name must be unique across all names -->
<add Name='sysadmin'/>

</Items>
</UserLogDefinitions>

Using Log Files
The Log files available from the Main Navigation Tree (page 3-15) can be used to assist in 
debugging and monitoring your Web Parts product. Follow this procedure to use log files:

1. Click Logs in the Main Navigation Tree (page 3-15).

2. Click Filter in the Search Results pane.

The Log Menu Screen (page 5-7) is displayed. 

3. Select the type of log you want to use. The following options are available from this 
menu:
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• ErrorsOnly: Error log files list the type of error received and possible corrective 
action.

• Keys Only: Key points in the log file are entry points to the Web Support Server 
(WSS). They denote at the highest level what calls are made into the content 
server. Use these log files to determine a specific location where errors are 
occurring.

• Keys and Errors Only: A Key and Error log file combines both types of log 
reports into one larger report.

• Show All: This option shows all log files not filtered by a type or a user. This can 
generate log files that may be too complete for easy use. 

• Activate Session Log: Activates logging for the active session. If logging is 
turned off, you can use this menu item to force logging to occur for the current 
session. Logging continues until the user who initiated the logging logs out or 
until Deactivate Session Log is selected. This option has no effect if logging is 
turned off for the entire Web Support Server.

• Deactivate Session Log: Deactivates logging for the active session. If logging is 
turned off and you selected Activate Session Log, select this menu item to 
deactivate session logging. This menu option has no effect if logging is turned on 
for the entire Web Support Server.

4. Choose a log type. 

The Log Filter Screen (page 5-7) is displayed.

5. Enter your filter values. Only items with values containing all the filter values will be 
displayed. The filter does not match your entries exactly so you can enter only part of 
a value if you do not know the entire value. Click OK when done.

The Log Results Screen (page 5-9) is displayed.

6. Select a log to view by clicking on the log item number.

The Log Details Screen (page 5-8) is displayed showing metadata about the log file. 

7. When done viewing the information, click OK.

Tech Tip: When logging for all logins, set the Message Filter to CreateSessionFor. All 
logins will be displayed. Session IDs can then be determined from those entries.
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ADMINISTRATION INTERFACE
The following screens are used by administrators to manage the Web Parts product 
product:

Main Admin Screen (page 5-6)

Log Menu Screen (page 5-7)

Log Filter Screen (page 5-7)

Log Details Screen (page 5-8)

Log Results Screen (page 5-9)

Main Admin Screen

The Main Admin screen is used to set defaults and alter directory paths. To access this 
screen, click Administration from the Main Navigation Tree (page 3-15).
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Log Menu Screen

The Log Menu screen is used to select the type of log you want to generate. To access this 
screen, click Log on the Main Navigation Tree (page 3-15).

Log Filter Screen

The Log Filter Screen is used to narrow the results returned for logging. To access this 
screen, select a log type from the Logs menu.
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Log Details Screen

The Log Details Screen is used to view metadata about a log file. To access this screen, 
click any log file name icon on the Log Results Screen (page 5-9).
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Log Results Screen

The Log screens are used to view error reports. To access these reports, click Logs from 
the Main Navigation Tree (page 3-15). A list of reports is displayed in the Search Results 
pane. To view the report, click the report name.
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A p p e n d i x

A.MODIFYING CONFIGURATION
SETTINGS

OVERVIEW
Many configuration tasks can be accomplished using the interface provided and described 
in Chapter 4 (Customizing the Software). This appendix describes other configuration 
options that can be performed by altering configuration files.

This section covers the following topics:

Using the WSS Config Editor (page A-2)

The Web Config File (page A-2)

The WebSupportServer.exe.config file (page A-5)

It is strongly recommended that you use the WSS Config Editor to edit any 
configuration parameters for the system. 

Caution: Do not alter portions of the configuration file that are not documented here. 
Altering the wrong portion can have unforeseen consequences.
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USING THE WSS CONFIG EDITOR
The WSS Config editor is stored in c:\Program Files\stellent\wss\WSSConfigEditor.exe. 
You can use this editor to change configuration information for your system.

To use the editor, click on the file name. The Config Editor screen is displayed. Six tabs 
indicate screens of information containing configuration details that can be changed. The 
configuration consists of a name and value pair. To change a setting, right click on the 
setting and select Edit to change the value.

The Settings tab contains configuration settings that are specific to the Web Support 
Server. The last item in the Settings list is the encrypted password for the system. 

The remainder of this chapter discusses the different settings which can be changed. Many 
of these can be changed in the configuration editor, and where possible, that tool should be 
used. However, not all functionality can be changed with the WSS Config Editor. Some 
configuration settings, such as mapped users, must be changed in configuration files. 

See the Configuration Interface Screens (page A-12) for screen shots of the WSS Config 
Editor configuration screens that can be used to change configuration settings.

THE WEB CONFIG FILE
The Web.Config file is used to configure the Web App functionality. This file is typically 
installed in the c:\Inetput\wwwroot\WebApp directory.

This section describes settings in the top-level WebApp Web.Config file. Each portion of 
the file is described by an XSLT ‘path’ to the section with a brief description of the 
content. Example snippets are also provided for each portion. Portions of this file that 
are not listed here should not be modified.

This section describes the following portions of the Web.Config file:

EmailFromName (page A-3)

EmailServerName (page A-3)

ErrorEmailRecipients (page A-3)

DiagnosticSetting.Logging (page A-4)

DiagnosticSetting.Timer (page A-4)

Important: When you first install the software, the system password is not encrypted. Use 
the Settings tab to encrypt the password used for the system. 
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DefaultUserTheme (page A-5)

EmailFromName
This setting configures the FROM email address and optional name from which diagnostic 
web server emails are sent.

XML Path: //configuration/appSettings/add[@key="EmailFromName"]

The value can be in one of two formats:

If specifying only the email address , use the email address:
"first.last@mycompany.com"

If using a specific name and an email address, use the following format: 
value="&quot;From Name&quot; &lt;first.last@mycompany.com&gt;"

Example:
<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">

  <appSettings>
    <add key="EmailFromName" value="&quot;WebApp System Monitor&quot;

&lt;some.name@somecompany.com&gt;" />
...

EmailServerName
This setting configures the outgoing email (SMTP) server to use when sending diagnostic 
web server emails.  The EmailFromName must be an authorized sender on that server.

XML Path: //configuration/appSettings/add[@key="EmailServerName"]

Example:
<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">

  <appSettings>
    <add key="EmailServerName" value="smtp.someserver.com" />
    ...

ErrorEmailRecipients
This setting configures the TO email address(es) and optional name(s) to which diagnostic 
web server emails will be sent.

XML Path: //configuration/appSettings/add[@key="ErrorEmailRecipients"]

Separate values using commas (,) or semicolons (;). Values can be in one of two formats:
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If specifying only the email address , use the email address:
"first.last@mycompany.com"

If using a specific name and an email address, use the following format: 
value="&quot;To Name&quot; &lt;first.last@mycompany.com&gt;"

Example:
<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
  <appSettings>
    <add key="ErrorEmailRecipients" value="first.recipient@somecompany.com,

&quot;Second Recipient&quot; &lt;second.recipient@somecompany.com&gt;" />
    ...

DiagnosticSetting.Logging
This setting enables / disables all event logging for the WebApp web server.  If this is set 
to off, the DiagnosticSetting.Timer setting is ignored.  If set to on, error dumps are output 
to the Application Event Log with the Source name of WebApp.

XML Path: //configuration/appSettings/add[@key="DiagnosticSetting.Logging"]

Setting a value to 1 enables logging. Setting to 0 disables all logging.

Example:
<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
  <appSettings>
    <add key="DiagnosticSetting.Logging" value="1" />
    ...

DiagnosticSetting.Timer
This setting enables or disables diagnostic timings logging for the WebApp web server.  If 
enabled, timings are output to the WebApp.Timings Event Log with source names related 
to web server operations, and time settings (HH:MM:SS.mmm) of actions (such as "WSS 
Call", "[Client] Download", etc) in the descriptions.

XML Path: //configuration/appSettings/add[@key="DiagnosticSetting.Timer"]

Setting a value to 1 enables timing logging. Setting to 0 disables the logging.

Example:
<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
  <appSettings>
    <add key="DiagnosticSetting.Timer" value="0" />
    ...
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DefaultUserTheme
This setting controls which theme will be shown to users by default when logging into the 
main WebApp portal. Themes may be hard-coded for items served in other contexts such 
as Content Server Web Parts that use the SharePoint theme. The theme name maps to a 
directory name under the WebApp install directory, which is typically stored at 
c:\Inetpub\wwwroot\WebApp\Styles\[Theme Name]. 

XML Path: //configuration/appSettings/add[@key="DefaultUserTheme"]

Example:
<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
  <appSettings>
    <add key="DefaultUserTheme" value="Outlook" />
    ...

THE WEBSUPPORTSERVER.EXE.CONFIG FILE
The WebSupportServer.exe.config file is used to configure elements such as the user 
names, navigation tree, and the search stack. This file is typically installed in the 
c:\Program Files\Stellent\WSS.

Each portion of the file is described by an XSLT ‘path’ to the section with a brief 
description of the content. Example snippets are also provided for each portion. Portions 
of this file that are not listed here should not be modified.

This section describes the following portions of the WebSupportServer.exe.config file:

Mapped Users (page A-6)

Profile Proxies Users (page A-6)

Activation Stack (page A-6)

Navigation Tree Content (page A-7)

Search Stack Definitions (page A-8)

User Log Definitions (page A-10)

App Settings (page A-11)
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Mapped Users
This setting lists all users who are mapped from external users to Content Server users.

XML Path: \configuration\ContentServer\SCSMappedUsers\Users

Example:
<SCSMappedUsers>

<Users>
<clear />
<add SourceName="ABSCSWP2\Administrator" TargetName="sysadmin" 
Password="idc" />

</Users>
</SCSMappedUsers>

Profile Proxies Users
This setting lists all Search Forms defined by the administrator. This has several example 
forms initially.  If not needed, they can be removed and replaced with custom versions.

XML Path: \configuration\ContentServer\SCSProfileProxies\Profiles

Example:
<SCSProfileProxies>

<Profiles>
<clear />
<add ProfileName="AllFields" DisplayName="All Fields" FieldList="*" />
<add ProfileName="DocTitle" DisplayName="By Title" FieldList="dDocTitle" />
<add ProfileName="Author" DisplayName="By Author" FieldList="dDocAuthor" />
<add ProfileName="AuthorAndTitle" DisplayName="By Author and Title" 
FieldList="dDocAuthor,dDocTitle" />

</Profiles>
</SCSProfileProxies>

Activation Stack
This setting describes which object will be used in the activation of a WSS session. The 
example shows the mapped user feature commented out by using the <!-- --> XML 
comment.

XML Path: \configuration\WebSupportServer\ActivationProviderStack

Important: Do not remove the "Web Support Server - Session Initialization" or the 
"Content Server User Validation" elements.  They are needed to create a WSS session and 
verify the user’s Content Server roles.
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Example:
<ActivationProviderStack>

<SynchronousItems>
<clear />
<!-- add Name="Content Server User Map"

ActivationProviderType="Stellent.Wss.Scs.ActivationProviders.SCSMappedUser
Provider,Stellent.Wss.Scs" / -->

<add Name="Web Support Server - Session Initialization"
ActivationProviderType="Stellent.IBPM.Web.WebSupportServerObjects.
ActivationProviders.WebSupportSessionIdProvider,WebSupportServerObjects"
Configuration="WebSupportUserName=IBPMUserName;WSS_AdminRoleName=WebAdmin" />

<add Name="Content Server User Validation"
ActivationProviderType="Stellent.Wss.Scs.ActivationProviders.SCSActivation
Provider,Stellent.Wss.Scs" />

</SynchronousItems>
<AsynchronousItems>

<clear />
</AsynchronousItems>
<ChangePasswordItems>

<clear />
</ChangePasswordItems>

</ActivationProviderStack>

Navigation Tree Content
This setting determines which nodes are loaded into the navigation tree web part.  
Customization could include removing tree items or changing the required roles to 
determine the existence of the elements. The example section here contains only the 
"SavedQueries" nav tree node.

XML Path: \configuration\WebSupportServer\NavTreeDefinitions\Items

Example:
<NavTreeDefinitions>

<Items>
<clear />
<add Name="SavedQueries"
NavTreeType="Stellent.Wss.Scs.NavigationTree.SCSNavTreeSavedSearches,
Stellent.Wss.Scs" />

</Items>
</NavTreeDefinitions>
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Search Stack Definitions
The search stack defines where WSS will obtain data for presentation to users.  Most of 
these items should not be altered or removed. However, some items specify 
Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.FilterAndOrderFields as a 
value for ResultsListPageFilterType. This defines the column content of the search results 
and the order of those columns. 

To change the column set and search results order, alter the ResultsListPageFilterConfig 
attribute which has a setting value of ColumnList.  The column list contains the names of 
the columns to include in the search results.  For example, the standard Content Server 
search results use a column list of the form:

"ColumnList=dDocTitle,dDocAuthor,dSecurityGroup,dDocName" 

which specifies the names of the columns to show.

Additionally, if ResultsListPageFilterConfig has a setting value of UseOrder=1 the order 
of the columns specified by "ColumnList" are used.

XML Path: \configuration\WebSupportServer\NavTreeDefinitions\Items

Example:
<SearchStackDefinitions>

<Items>
<clear />

<add Name="Content.ProfileProxies"
ResultsListSourceType="Stellent.Wss.Scs.ResultsListSources.SCSProfile
ProxiesResultsList, Stellent.Wss.Scs" 
CreateResultsListWhenMissing="true"
ResultsListPageFilterType="Stellent.IBPM.Web.WebSupportServerObjects.Folder
Filters.FilterAndOrderFields"
ResultsListPageFilterConfig="ColumnList=DisplayName,FieldList;UseOrder=1" />

<add Name="WSS.Logs"
ResultsListSourceType="Stellent.IBPM.Web.WebSupportServerObjects.
ResultsListSources.WSSLogViewer" 
CreateResultsListWhenMissing="true" ResultsListPageFilterType=
"Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.FilterAndOrderFields"
ResultsListPageFilterConfig="ColumnList=Msg,Time,
Elapsed,ThreadId;UseOrder=1" />

<add Name="Content" NameListSourceType="Stellent.Wss.Scs.NameListSources.
SCSProfileNameListSource, Stellent.Wss.Scs" PromtsListSourceType=
"Stellent.Wss.Scs.PromptListSource.SCSSearchFormPromptListSource,
Stellent.Wss.Scs" ResultsListSourceType=
"Stellent.Wss.Scs.ResultsListSources.SCSContentResultsListSource,
Stellent.Wss.Scs" ResultsListPageFilterType=
"Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.
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FilterAndOrderFields" ResultsListPageFilterConfig="ColumnList=
dDocTitle,dDocAuthor,dSecurityGroup,
dDocName;UseOrder=1" CreateResultsListWhenMissing="true" />

<add Name="Content.Subscriptions" NameListSourceType=
"Stellent.Wss.Scs.NameListSources.SCSSubscriptionsNls,Stellent.Wss.Scs"
PromtsListSourceType="Stellent.Wss.Scs.PromptListSource.SCSDetailsViewPls,
Stellent.Wss.Scs" ResultsListSourceType="Stellent.Wss.Scs.ResultsListSources.
SCSSubscriptionsResultsList, Stellent.Wss.Scs" ResultsListPageFilterType=
"Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.FilterAndOrderFields" 
ResultsListPageFilterConfig="ColumnList=dDocTitle;UseOrder=1"
CreateResultsListWhenMissing="true" />

<add Name="Content.CheckedOut"
NameListSourceType="Stellent.Wss.Scs.NameListSources.SCSCheckInsNls,
Stellent.Wss.Scs"
PromtsListSourceType="Stellent.Wss.Scs.PromptListSource.SCSDetailsViewPls,
Stellent.Wss.Scs"
ResultsListSourceType="Stellent.Wss.Scs.ResultsListSources.
SCSCheckInsResultsList, Stellent.Wss.Scs" ResultsListPageFilterType=
"Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.FilterAndOrderFields"
ResultsListPageFilterConfig="ColumnList=dDocTitle,dCheckoutUser,dDocName;
UseOrder=1" CreateResultsListWhenMissing="true" />

<add Name="Content.MyWorkflow"
NameListSourceType="Stellent.Wss.Scs.NameListSources.SCSWorkflowNls,
Stellent.Wss.Scs"
PromtsListSourceType="Stellent.Wss.Scs.PromptListSource.SCSDetailsViewPls,
Stellent.Wss.Scs"
ResultsListSourceType=
"Stellent.Wss.Scs.ResultsListSources.SCSWorkflowResultsList,Stellent.Wss.Scs"
ResultsListPageFilterType="Stellent.IBPM.Web.WebSupportServerObjects.
FolderFilters.FilterAndOrderFields"
ResultsListPageFilterConfig=
"ColumnList=dDocTitle,dDocName,wfQueueLastActionTs, 
wfQueueActionState,wfQueueEnterTs;
UseOrder=1" CreateResultsListWhenMissing="true" />

<add Name="Content.Users"
NameListSourceType="Stellent.Wss.Scs.NameListSources.SCSUserNls,
Stellent.Wss.Scs" PromtsListSourceType=
"Stellent.Wss.Scs.PromptListSource.SCSDetailsViewPls,Stellent.Wss.Scs"
ResultsListSourceType=
"Stellent.Wss.Scs.ResultsListSources.SCSUserNameResultsList, Stellent.Wss.Scs"
ResultsListPageFilterType=
"Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.FilterAndOrderFields"
ResultsListPageFilterConfig="ColumnList=dName,dFullName,dEmail;UseOrder=1"
CreateResultsListWhenMissing="true" />

<add Name="Content.MappedUsers"
NameListSourceType="Stellent.Wss.Scs.NameListSources.SCSUserNls,
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Stellent.Wss.Scs" PromtsListSourceType=
"Stellent.Wss.Scs.PromptListSource.SCSDetailsViewPls,Stellent.Wss.Scs"
ResultsListSourceType="Stellent.Wss.Scs.ResultsListSources.SCSUser
MapResultsList, Stellent.Wss.Scs" CreateResultsListWhenMissing="true" />

<add Name="Content.MyUrls"
ResultsListSourceType="Stellent.Wss.Scs.ResultsListSources.SCSPersonalUrlsResults

List, Stellent.Wss.Scs" CreateResultsListWhenMissing="true" />
<add Name="Content.ContributionFolders"

ResultsListSourceType="Stellent.Wss.Scs.ResultsListSources.
SCSContributionFolder ResultsList, Stellent.Wss.Scs" 
ResultsListPageFilterType=
"Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.FilterAndOrderFields"
ResultsListPageFilterConfig="ColumnList=
wssDisplayedName,dReleaseDate,dDocAuthor;
UseOrder=1" CreateResultsListWhenMissing="true" />

<add Name="Content.DocumentRevisions"
ResultsListSourceType="Stellent.Wss.Scs.ResultsListSources.
SCSRevisionResultsList, Stellent.Wss.Scs" ResultsListPageFilterType=
"Stellent.IBPM.Web.WebSupportServerObjects.FolderFilters.FilterAndOrderFields"
ResultsListPageFilterConfig="ColumnList=
dStatus,dInDate,dOutDate,dStatus,dRevision
ID;UseOrder=1" CreateResultsListWhenMissing="true" />

</Items>
</SearchStackDefinitions>

User Log Definitions
This setting lists the users that will have active logging.  To activate WSS logging for a 
particular username add that username to this list.  The example causes the session logging 
to turn on for any user logged in as "SysAdmin" or "RRogers".

XML Path: \configuration\WebSupportServer\UserLogDefinitions\Items

Example:
<UserLogDefinitions>

<Items>
<clear />
<!-- Name must be unique across all names -->
<add Name="sysadmin"/>
<add Name="RRogers"/>

</Items>
</UserLogDefinitions>
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App Settings
Several other AppSettings used by WSS and the Web Parts can be changed, including 
cache folder location, WSS session timeout, and Content Server port. The following 
example shows several of these configuration. The text in bold font indicates the 
pertinent section.

Example: 
<appSettings>
<!-- The Cache folder used to cache global and user session data -->

<add key="WebSupportServer.CacheDirectory" value=
"C:\Program Files\Stellent\WSS\WebSupportServerCache" />

<!-- Debug and Tracing - This turns logging on for all WSS Activity -->
<add key="WebSupportServer.Trace" value="false" />
<!-- Debug and Tracing - If logging is on this should be turned on -->
<add key="WebSupportServer.UseConsole" value="false" />
<!-- Debug and Tracing - This turns on logging for Entry points into WSS-->
<add key="WebSupportServer.KeyPoints" value="false" />

<!-- Session Infrastructure - This is the WSS Session timeout.  Any session 
with no activity for this number of minutes is cleaned up on WSS -->
<add key="WebSupportServer.SessionStore.SessionTimeoutMinutes" value="20" />

<!-- Session Infrastructure - This is the WSS Global Cache timeout.  After 
this number of minutes WSS will flush its cache causeing any access of global 
cache to be refreshed.  Things like Folder Structure in the Contribution folders 
or Field Definitions are cached at WSS for efficiency.  -->
<add key="WebSupportServer.SessionStore.GlobalCacheTimeoutMinutes" value="480" />

<!-- List Row Counts - These are the default row counts in the pages presented 
to the user -->
<add key="WebSupportServer.DefaultUserSetting.Content.PageRowCount" value="10" />
<add key="WebSupportServer.DefaultUserSetting.WSS.Logs.PageRowCount" value="50" />

<!-- Stellent Content Server Settings - This is the URL to the Content 
Server web services used by WSS -->
<add key="StellentContentServer.WebServiceConnectionUrl" value="http://cos-
jjumper/stellentcs/idcplg" />

<!-- Stellent Content Server Settings - This is the System user used for Web 
Services User Proxy along with that password used for the user -->
<add key="Stellent.Scs.DirectServiceSupport.StellentRequest.Communication.

SystemUser" value="sysadmin" />
<add key="Stellent.Scs.WebServiceSupport.SystemUserName" value="sysadmin" />
<add key="Stellent.Scs.WebServiceSupport.SystemUserPassword" value="idc" />
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<!-- Stellent Content Server Settings - This is the Content Server port used 
to comunicate through the socket layer to content server  -->
<add key="Stellent.Scs.DirectServiceSupport.StellentRequest.Communication.

EndPoint" value="4444" />

CONFIGURATION INTERFACE SCREENS
The following screens are used with the WSS Config Editor to configure the Web Parts 
product system:

Application Settings Screen (page A-13)

Activation Stack Screen (page A-14)

Search Stack Screen (page A-15)

Navigation Tree Screen (page A-16)

View Providers Screen (page A-17)

Filter Stacks Screen (page A-18)
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Application Settings Screen

The Application Settings screen is used to change configuration values for the session 
timeout, the connection URL for the Content Server and other configuration for Web 
Support Server operation. To access this screen, click the Settings tab on the WSS Config 
Editor window.
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Activation Stack Screen

The Activation Stack screen is used to initialize the activation keys and customize the 
Activation Stack. To access this screen, click the Activation Stack tab on the WSS Config 
Editor window.
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Search Stack Screen

The Search Stack screen defines the named stacks of class types used to obtain 
information from the back end system. To access this screen, click the Search Stack tab 
on the WSS Config Editor window.
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Navigation Tree Screen

The Navigation Tree screen defines the content of the Navigation list shown in the web 
application. You can customize this tree by adding or removing nodes. To access this 
screen, click the Navigation Tree tab on the WSS Config Editor window.
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View Providers Screen

The View Providers screen shows a list of providers that are mapped to items. To access 
this screen, click the View Providers tab on the WSS Config Editor window.
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Filter Stacks Screen

The Filter Stacks screen filter and transform result sets as they are returned in requests. To 
access this screen, click the Filter Stacks tab on the WSS Config Editor window.
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A p p e n d i x

B.THIRD PARTY LICENSES

OVERVIEW
This appendix includes a description of the Third Party Licenses for all the third party 
products included with this product.

Apache Software License (page B-1)

W3C® Software Notice and License (page B-2)

Zlib License (page B-4)

General BSD License (page B-5)

General MIT License (page B-5)

Unicode License (page B-6)

Miscellaneous Attributions (page B-7)

APACHE SOFTWARE LICENSE
* Copyright 1999-2004 The Apache Software Foundation.

* Licensed under the Apache License, Version 2.0 (the "License");

* you may not use this file except in compliance with the License.

* You may obtain a copy of the License at

*      http://www.apache.org/licenses/LICENSE-2.0

* 
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* Unless required by applicable law or agreed to in writing, software

* distributed under the License is distributed on an "AS IS" BASIS,

 * WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

 * See the License for the specific language governing permissions and

 * limitations under the License.

W3C® SOFTWARE NOTICE AND LICENSE
* Copyright © 1994-2000 World Wide Web Consortium, 

* (Massachusetts Institute of Technology, Institut National de 

* Recherche en Informatique et en Automatique, Keio University). 

* All Rights Reserved.  http://www.w3.org/Consortium/Legal/

* 

* This W3C work (including software, documents, or other related items) is

* being provided by the copyright holders under the following license. By

* obtaining, using and/or copying this work, you (the licensee) agree that

* you have read, understood, and will comply with the following terms and

* conditions:

* 

* Permission to use, copy, modify, and distribute this software and its

* documentation, with or without modification, for any purpose and without

* fee or royalty is hereby granted, provided that you include the following

* on ALL copies of the software and documentation or portions thereof,

* including modifications, that you make:

* 

*   1. The full text of this NOTICE in a location viewable to users of the

*      redistributed or derivative work.

* 

*   2. Any pre-existing intellectual property disclaimers, notices, or terms
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*      and conditions. If none exist, a short notice of the following form

*      (hypertext is preferred, text is permitted) should be used within the

*      body of any redistributed or derivative code: "Copyright ©

*      [$date-of-software] World Wide Web Consortium, (Massachusetts

*      Institute of Technology, Institut National de Recherche en

*      Informatique et en Automatique, Keio University). All Rights

*      Reserved. http://www.w3.org/Consortium/Legal/"

* 

*   3. Notice of any changes or modifications to the W3C files, including the

*      date changes were made. (We recommend you provide URIs to the location

*      from which the code is derived.)

* 

* THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS

* MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT

* NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR

* PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE

* ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

* 

* COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR

* CONSEQUENTIAL DAMAGES ARISING OUT OF ANY USE OF THE SOFTWARE OR

* DOCUMENTATION.

* 

* The name and trademarks of copyright holders may NOT be used in advertising

* or publicity pertaining to the software without specific, written prior

* permission. Title to copyright in this software and any associated

* documentation will at all times remain with copyright holders.

*
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ZLIB LICENSE
* zlib.h -- interface of the 'zlib' general purpose compression library

  version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied

  warranty.  In no event will the authors be held liable for any damages

  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,

  including commercial applications, and to alter it and redistribute it

  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not

     claim that you wrote the original software. If you use this software

     in a product, an acknowledgment in the product documentation would be

     appreciated but is not required.

  2. Altered source versions must be plainly marked as such, and must not be

     misrepresented as being the original software.

  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly jloup@gzip.org

  Mark Adler madler@alumni.caltech.edu
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GENERAL BSD LICENSE
Copyright (c) 1998, Regents of the University of California

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 

are permitted provided that the following conditions are met:

"Redistributions of source code must retain the above copyright notice, this 

list of conditions and the following disclaimer. 

"Redistributions in binary form must reproduce the above copyright notice, this 

list of conditions and the following disclaimer in the documentation and/or other 

materials provided with the distribution. 

"Neither the name of the <ORGANIZATION> nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific 

prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 

IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 

PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE.

GENERAL MIT LICENSE
Copyright (c) 1998, Regents of the Massachusetts Institute of Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software and associated documentation files (the "Software"), to deal in the 

Software without restriction, including without limitation the rights to use, copy, 

modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 

and to permit persons to whom the Software is furnished to do so, subject to the 

following conditions:
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The above copyright notice and this permission notice shall be included in all 

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

UNICODE LICENSE
UNICODE, INC. LICENSE AGREEMENT - DATA FILES AND SOFTWARE

Unicode Data Files include all data files under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/ . Unicode Software includes any source code 

published in the Unicode Standard or under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/.

NOTICE TO USER: Carefully read the following legal agreement. BY DOWNLOADING, 

INSTALLING, COPYING OR OTHERWISE USING UNICODE INC.'S DATA FILES ("DATA FILES"), 

AND/OR SOFTWARE ("SOFTWARE"), YOU UNEQUIVOCALLY ACCEPT, AND AGREE TO BE BOUND BY, 

ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT 

DOWNLOAD, INSTALL, COPY, DISTRIBUTE OR USE THE DATA FILES OR SOFTWARE.

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1991-2006 Unicode, Inc. All rights reserved. Distributed under the 

Terms of Use in http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a copy of the 

Unicode data files and any associated documentation (the "Data Files") or Unicode 

software and any associated documentation (the "Software") to deal in the Data 

Files or Software without restriction, including without limitation the rights to 

use, copy, modify, merge, publish, distribute, and/or sell copies of the Data Files 

or Software, and to permit persons to whom the Data Files or Software are furnished 

to do so, provided that (a) the above copyright notice(s) and this permission notice 

appear with all copies of the Data Files or Software, (b) both the above copyright 

notice(s) and this permission notice appear in associated documentation, and (c) 

there is clear notice in each modified Data File or in the Software as well as in 

the documentation associated with the Data File(s) or Software that the data or 

software has been modified.
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THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO 

EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR 

ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 

CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 

THE USE OR PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used 

in advertising or otherwise to promote the sale, use or other dealings in these Data 

Files or Software without prior written authorization of the copyright holder.

________________________________________Unicode and the Unicode logo are trademarks 

of Unicode, Inc., and may be registered in some jurisdictions. All other trademarks 

and registered trademarks mentioned herein are the property of their respective 

owners

MISCELLANEOUS ATTRIBUTIONS
Adobe, Acrobat, and the Acrobat Logo are registered trademarks of Adobe Systems 
Incorporated.

FAST Instream is a trademark of Fast Search and Transfer ASA.

HP-UX is a registered trademark of Hewlett-Packard Company.

IBM, Informix, and DB2 are registered trademarks of IBM Corporation.

Jaws PDF Library is a registered trademark of Global Graphics Software Ltd.

Kofax is a registered trademark, and Ascent and Ascent Capture are trademarks of 
Kofax Image Products.

Linux is a registered trademark of Linus Torvalds.

Mac is a registered trademark, and Safari is a trademark of Apple Computer, Inc.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft 
Corporation.

MrSID is property of LizardTech, Inc. It is protected by U.S. Patent No. 5,710,835. 
Foreign Patents Pending.

Oracle is a registered trademark of Oracle Corporation.

Portions Copyright © 1994-1997 LEAD Technologies, Inc. All rights reserved.

Portions Copyright © 1990-1998 Handmade Software, Inc. All rights reserved.

Portions Copyright © 1988, 1997 Aladdin Enterprises. All rights reserved.
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Portions Copyright © 1997 Soft Horizons. All rights reserved.

Portions Copyright © 1995-1999 LizardTech, Inc. All rights reserved.

Red Hat is a registered trademark of Red Hat, Inc.

Sun is a registered trademark, and Sun ONE, Solaris, iPlanet and Java are trademarks 
of Sun Microsystems, Inc.

Sybase is a registered trademark of Sybase, Inc.

UNIX is a registered trademark of The Open Group.

Verity is a registered trademark of Autonomy Corporation plc
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Select Sign On Support Screen, 2-15
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SharePoint Main Screen, 2-19
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